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On the Way to Computer
and Information Literacy

Objectives

1. Introduce the concepts of information and computer literacy.

2. Review the organization of this book.

3. ldentify elements of a computer lab system.

4. Log in to a computer system.

5. Create a PDF file.

6. Compress and unzip a file.

7. Download and upload an email attachment.

8. Develop basic skill in using OneNote to explore a few computer and infor-

mation literacy concepts.

Healthcare professionals increasingly rely on information systems to assist
them in providing quality care. They realize that a large percentage of their
practice involves the management of information. Computers are often
required to perform information-related functions such as sorting and
addressing patient needs and documenting care; providing remote patient care
through telemedicine facilities; organizing, calculating, and managing finan-
cial data; and accessing healthcare literature. To use the tools of automation in
meeting their responsibilities and take advantage of evolving computer tech-
nologies, healthcare professionals must be computer and information literate.
This book is designed to help you develop the essential computer and
information literacy skills needed by all healthcare professionals. Its focus is
the introduction of concepts that cross specific applications and the devel-
opment of practical computer skills. In each chapter, exercises from the
healthcare arena provide practice in applying the concepts and skills.
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. 2 CHAPTER 1: On the Way to Computer and Information Literacy

Literacy

Healthcare providers learn to use a stethoscope as a tool to assess patients. This
practice involves understanding the function and purpose of the stethoscope as
well as developing skill in using it. Just as healthcare providers learn to use the
stethoscope, so they must also learn the function and purpose of computers in
health care as well as develop skill in their use. In other words, healthcare pro-
viders must become “computer and information literate.”

Literacy

Computer Literacy

Information Literacy

Literacy means the ability to locate and use printed and
written information to make decisions and to function
in society, both personally and professionally.

Add “computer” to the term “literacy,” and it refers to
the ability to use the computer to do practical tasks. A
variety of viewpoints exist that identify computer skills
required for computer literacy, but there is general
agreement that computer literacy includes the ability
to use basic computer applications to complete tasks.
This term describes a set of skills that enables a person
to identify an information need, locate and access the
required information many times by using technology,
evaluate the information found, and communicate
and use that information effectively. With the explo-
sion of information, both good and bad, information
literacy has taken on a major role in all educational
settings. Given information literacy’s growing impor-
tance, Chapter 12 provides further information on this
topic.

People who are computer and information literate have the following charac-

teristics: They

use the computer and associated software as tools to complete their work in
a more effective and efficient manner.

recognize the need for accurate and complete information as the basis for
intelligent decision making.

find appropriate sources of information using successful search strategies.
evaluate and manage information to facilitate their work.

communicate information in various formats.

integrate technology and information strategies into their daily professional

lives.
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Organization

Many professional organizations and accrediting agencies now include infor-
mation and computer literacy requirements as part of their criteria. For example,
the Association of College and Research Libraries (ACRL) produced a document
defining and outlining specific criteria and standards for demonstrating informa-
tion literacy (Association of College and Research Libraries, 2000). To support
the development of information literacy, the ACRL has establish a Web site with
links and citations to information literacy standards and curricula developed by
accrediting agencies, professional associations, and institutions of higher educa-
tion. Several of the healthcare professions are included in its site. The ACRL Web
site can be viewed at http://www.ala.org/ala/mgrps/divs/acrl/about/sections/is/
projpubs/infolitdisciplines/index.cfm.

Organization of the Book

This book consists of 14 chapters and an index that features highlighted computer
terms. Most chapters are organized in the same way, beginning with a lesson that
introduces the content, describes key concepts and terms, and, in application chap-
ters, provides descriptions of common application functions and keystrokes. Each
chapter also includes one or more exercises for use in the classroom or computer
laboratory to practice application of lesson concepts and one or more assign-
ments intended for you to demonstrate the knowledge and skill acquired. Additional
materials for exercises and assignments can be downloaded from the book’s Web site.

The first chapter provides material that is useful to understanding and using
this book as well as an introduction to OneNote. Chapters 2, 3, and 4 contain
content about hardware and software. Computer hardware and software terms
are introduced in Chapter 2. Chapter 3 focuses on managing the computer envi-
ronment. Chapter 4 covers tasks that are common to most application programs.
As a consequence of this consistency, many applications in a graphic environ-
ment have common looks and functions.

The next four chapters include lessons and practice exercises for word pro-
cessing, presentation graphics, spreadsheet, and database applications. Microsoft
Office 2007 is used to illustrate the basic concepts of each of these chapters.

Basic Internet concepts for connecting and browsing, and related software such as
Internet Explorer and Firefox, are then introduced. Tips for successful communica-
tion over the Internet and in distance education endeavors are shared in Chapters 9,
10, and 11. Means of accessing informational resources and issues of security, integ-
rity, and ethical use of electronic data are reviewed in Chapters 12 and 13. Chapter 14
provides an introduction to the field of healthcare informatics.

Every attempt was made to select Internet sites that would exist while this
book is used and that demonstrate the concepts presented. Remember, however,
that Internet sites can and do change, so some of the links may not work.
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On the Way to Computer and Information Literacy

Before Beginning: Some Helpful Information

Every computer system and every computer laboratory have subtle differences
that can cause problems for the beginner; therefore, learning something about
the computer environment used is essential. Professors or computer laboratory
personnel can help to answer the following questions:

Accounts Is an account needed to use the computer laboratory
or university’s resources? If so, what is the process
for getting one? Some schools have at least a 24-hour
wait time before the laboratories can be used. By com-
parison, some other schools automatically create an
account when a student registers or provide facili-
ties and directions to create an instant account. Some
schools require students to own laptops, but you still
need an account to sign on to the school’s network. A
separate account may also be needed to access course
materials made available through the Internet or that
reside on course management software servers.

Computer Where are the computer laboratories located, and who

Laboratories has access to them? Is an identification card needed
to use the equipment and software? Are some labora-
tories reserved for specific student populations—for
example, health professional students or engineering
students—or are all laboratories general-purpose facil-
ities that are available to all students, staff, and faculty?

Cost Is there a user charge for accessing and using the com-
puter equipment and software? Do the rates vary (less
at night or during off-peak times)? Is a computer fee
included in tuition charges? What does the fee cover?

Documentation Does the computer laboratory have user documen-
tation? Where is the documentation? Are handouts
available in the computer laboratory, or are the docu-
ments available online to read and/or print? Which
documentation is needed to begin? Most computer
laboratories have user documentation that provides
helpful information for starting and learning specific
software programs. For example, the laboratory might
have a document called “Getting Started with Out-
look” or “Accessing the Network from Home.”

Equipment/Storage Which type of hardware will be used? Which types
of storage devices are needed, and where can they be
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Before Beginning: Some Helpful Information 5 .

purchased? How is the equipment turned on? Where
can students store data files?

Laboratory Hours What are the laboratory hours? Do they change during
the term? Is the laboratory open over the weekend?
Some laboratories expand their hours of operation
toward the end of the term when many papers and
projects are due. Does a laboratory assistant need to be
present for the laboratory to be open, or is the labora-
tory left unattended?

Lease or Buy Does the university have a program whereby students
lease or buy a laptop computer for use at home, in the
dormitory, or in the classroom? If so, how long does it
take to get a computer? How does the university sup-
port this program in terms of repair, software, and
other technical issues? Is a certain operating system
(i.e., PC or Mac) required? Can you buy the computer
at the end of the lease?

Logging In Most resources that you will need as a student and as
a professional will require you to log in to the system.
Some institutions will have a universal login that pro-
vides a customized home page (referred to as a portal)
with all your resources a click away; other institu-
tions require separate accounts for each resource like
the network, email, library online databases, student
records, course management software, patient clinical
records, drug administration systems, and so forth.

Is there a log-in procedure (a series of steps to
access the computer software)? If so, how do you log
into the system? Is there a help sheet to follow?

Mobile Devices Are there places around campus where students with
laptops can connect to the resources available on the
network? Is it wireless or wired? What are the require-
ments for connecting your laptop to the network while
on campus?

Policies What are the policies that govern use of the computer
laboratory? Policies can include anything from how often
to change a password to how many pages can be printed
each term to respecting the rights of other users. What are
the penalties for not adhering to the policies? Penalties
might range from a warning for a minor offense to dis-
missal or expulsion for a major offense. Most computer
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. 6 CHAPTER 1: On the Way to Computer and Information Literacy

Printing

Rules

Support/Help

laboratories and organizations or businesses provide
the policies to each account holder or give directions
for viewing them online. If this is an employee account
(rather than a student account), certain policies related to
confidentiality of data and protection of a password need
to be acknowledged and followed.

Which printing capabilities are available in the labora-
tory? Is there access to color printing? Is there a charge
for printing? Some schools use a prepaid print card, keep
an electronic record of printing that allows individual
billing, or use a software program such as PaperCut to
keep track of printing costs. When the printing credits go
to zero, the student must add more print credits to con-
tinue printing. Other schools permit unlimited printing.
What are the rules that govern use of the computer
laboratory? Many laboratories prohibit eating and
drinking, chatting, and game playing. Laboratories
can be restricted to academic use only. Some labora-
tories also check all removable storage devices that are
brought into the laboratory for viruses.

What kind of support is available when help is needed?
Many laboratories provide helpers to assist patrons
who have questions or are experiencing problems.
Others provide online help services and quick ref-
erence guides for their users. Are there orientation
classes for the laboratories and/or training classes on
specific software? What is the telephone number for
the help desk? What is its email address?

Getting Started with Your Computer

It is wise to review the material in this section before beginning work on a computer.

Enter

Bold

Used throughout this book, Enter refers to the Enter
or return key. When the word “Enter” appears in this
book, do not type it. Instead, press the Enter or return
key; it is usually marked with a left-pointing arrow.

Instructions in bold indicate what to click on, which
keys to press, or what to type. Computers are very
exacting. A misspelled word or failure to place a blank
where a blank is needed may result in an error mes-
sage. Make sure what is typed is exactly what is bolded.
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Ctrl+X When Ctrl (or Alt or Shift) appears followed by a plus
sign (+) and function key number or letter, press the
first key and then, while holding it down, press the cor-
rect function or letter key. Release both keys together.

Version The specific sequence and location of commands vary
with different versions of software. In this book, Micro-
soft Office 2007 is used for the word processing, presen-
tation graphics, spreadsheet, and database content, and
Internet Explorer (version 7) and Firefox (version 3) are
used for the two browsers. If your computer is a Mac
equipped with Office 2008 or Safari (browser), some of
the specific commands will be different.

Windows/Mac OS Although the exercises for Word, Excel, Access, Power-
Point, Internet Explorer, and Firefox were written using
Windows Vista, Mac-based programs can just as easily
be used for these exercises. Most of the keystrokes are
exactly the same. A few menu items and a few keys on
the keyboard are different. Although every attempt
was made to replicate the windows in true form, your
system may display some variations in terms of how the
window “looks.” Despite these minor differences, you
should be able to follow along in the exercises.

Learning a Few Basic Skills
Logging In
To log in:

1. Access the system. This may mean typing an address in a browser like
intranet.laroche.edu to access the main internal Web page, pressing
Ctrl+Alt+Delete to access the login screen, or opening an icon on the
desktop for a specific system. Figure 1-1 provides two examples.

. Type your UserID or user name in the appropriate textbox.

3. Type your password in the appropriate text box. NOTE: The password will

not show but will have asterisks in place of the letters and numbers typed.
Some system passwords are case sensitive.

N

NOTE: Some systems you access may have specific settings required for them to function
properly. For example, Blackboard requires JavaScript and cookies enabled while Micro-
soft's Web-based access to Qutlook requires popups to be enabled. Your institution should
provide you with how to enable these should they be required.
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I__- 4| I Blackboard Academic Suite
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«+—Type password

Figure 1-1 Two Login Examples

File Formats

Working in the computer environment requires some knowledge of working with
files that you might need for a class or that you might need to send to your professor.
Two things you might have to do are to (1) create or open a PDF (portable docu-
ment format) file or (2) compress/decompress a file. PDF is a fixed-layout format
often used in publishing. Two popular fixed-layout formats are Adobe PDF and

£3 Suticok Web Access

Pronided by Microaoft Exchasge Sorver 2

F Torhoe amaihj1 2o 231 4 Type user name or ID
e — Type password

Logon
4
Click here

or press
enter

Microsoft’s PDF and XPS (XML Paper Specification).

To create a PDF file, you will need to install a free Office add-in utility (or plug-in) or
use another program like PDFCreator that may be installed on laboratory computers.

To download the Microsoft utility:

1. Start Internet Explorer or another browser.

. Type office.microsoft.com/en-us/downloads/ in the URL or address text

box and press Enter.

. In the search box, type Microsoft Office Add-in save as PDF and click the

Search button. See Figure 1-2.

(op IS I~

. To install the download:

a. Click the Download button |_Download ] At the File Download—
Security Warning dialog box, click the Save button and save

. Click the hyperlink for Microsoft Office Add-in save as PDF.
. Review the System Requirements, Overview, and Instructions sections.

the file to your hard disk on the desktop or download folder.

. At the Download Complete dialog box, click the Run button .
Alternatively, you may install the utility later. To do this, double-click
the SaveAsPDFandXPS.exe program file on your desktop or in your

download folder to staﬁ&ge Setup program.
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Add-ns
= Office 2000 el

Searched Downloads for "Microsoft Office Add-in save ..."

R Wiznt better search results? Tador results to the Mirosoft Office products you have nstalled.

Figure 1-2 Microsoft Office Download Window

C. If selecting the Run option, follow the instructions on the screen to com-
plete the installation. This may require accepting the software agreement
and/or clicking Continue as those windows pop up.

NOTE: You can also click the Office button, Save as, and PDF or XPS format toward the
bottom of the menu. Verify that you have a legal copy of Microsoft Office and follow the
screen directions to download it.
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To save a file in PDF format:

1. Open the document you want to publish.

2. Click the Office button [EE' and then point to Save As.

3. When the pop-up menu appears, click PDF or XPS.

4. Type a name and select a location for the saved file or accept the default
name and location.

NOTE: The procedure for creating a PDF file may vary depending on the program you are
using. Some require you to select Publish to or Print, Print, and to change the printer to
Adobe PDF.

For more information, search Microsoft Office Help online for “Save a file in
PDF format” or “Save a file in XPS format.”

Compression Files

Both Windows Vista and Windows XP come with a compression utility that allows
you to send or receive large or multiple files. Other programs that zip and unzip files
include WinZip and Stufflt. Faculty may send textbook files to you as email attach-
ments or place them on a file server. Many of these files are compressed.

To compress a file:

1. Select the file or folder from your storage device.

2. Right-click the file or folder.

3. Choose Send To and then Compressed (Zipped) Folder. (See Figure 1-3.) A
compressed folder E appears in the same place as the original folder. It may
look like this g if you are using WinZip.

To unzip a file:

1. Double-click the compressed file or folder. You may also right-click the
compressed file or folder, choose Open with, and then choose Compressed
(Zipped) Folder or WinZip. See Figure 1-4.

2. Figure 1-5 shows the dialog window that appears with the contents of the
zipped file. Note that your window might look slightly different but will
function similarly.

3. Select the appropriate file or folder to extract and then click the extract all
files text. Again, a button %_ may be available on a toolbar that you can
use to extract files, dependmg on the program.

Although you can view compressed files, they will not work properly until they
are extracted.
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Figure 1-3
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Figure 1-4
Dialog Box

for Opening a
Compressed File/
Folder
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Share...
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WinZip

Scan with Norton Internet Security
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Cut
Copy
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3. Compressed folder

Com| sed (zipped) Folder
Desktop (create shortcut)
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Mail Recipient

DVD RW Drive (E:)

CD Drive (F:) U3 System

e COMPBOOK (I:)

Open
Search...

Browse with Paint Shop Pro X
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@3Perform Security Sweep
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Send To
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Copy
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@ Firefox
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Using Windows XP

3400
1ST REVISE




© Jones and Bartlett Publishers, LLC. NOT FOR SALE OR DISTRIBUTION

. 12 CHAPTER 1: On the Way to Computer and Information Literacy

1. Right-click file or folder

Open
Explore
Open as Notebook in OneNote

Share...
Snaglt
WinZip

3. Compressed folder
Scan with Norton Internet Security P

Send To#~ 2_Click Send to , Com, ed (zipped) Folder

Cut Desktop (create shortcut)

Documents
Copy

Mail Recipient
Create Shortcut -2 DVD RW Drive (E)
Delete ) CD Drive (F:) U3 System

Rename COMPBOOK (k)

Figure 1-5 Dialog Boxes for Opening a Compressed File/Folder
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Email Attachments

In addition to saving files in PDF format and extracting compressed files, you
may need to download a file attached to an email message or attach one of your
assignments to an email message.

To download an email attachment:

1. Open the email program and display the mail message.

2. Look for words or a paper clip ,,, that indicates an attachment. It should look

something like this: Attachments: 1) Figwer Sales.pptx(1M8) ) presentationcD. zio(12M8)
3. Right-click the file and save target as (or something similar to those words).
4. Select a place to download the file.

Each mail program is slightly different in terms of the location and display of
the attached file. Nevertheless, all programs should give you the ability to right-
click and save the file to a specific location.

To attach a file to an email:

1. Open the email program and look for words like compose mail
or new message [ s:new ~. Click the words to start and com-
pose a message.

2. Once the message is composed, look for a paper clip A Attach a file or
attachment words m] Click the words or paper clip.

3. Complete the window that appears asking for the location and file to attach.
Make sure the attachment appears in the mail message window before you
send the message.

Introduction to OneNote

Microsoft Office OneNote 2007 provides you with an electronic tool for orga-
nizing and storing information such as notes from class, reference materials, and
Internet sources. Information is gathered in electronic notebooks that are equiv-
alent to traditional three-ring binders, where each notebook has sections and
pages. You can store almost any kind of electronic information in OneNote, such
as photos, text, graphics, audio, Web clippings, and video clips. You can write a
note with the keyboard, write a note with a “pen,” or copy something from the
screen and paste it into OneNote or even into another Office document. When
you copy something from the Internet, the address from which you copied the
information will automatically appear on the OneNote page. Many of the small
figures or icons used in this book were captured using OneNote. OneNote does
not use the ribbon concept of Office 2007.
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OmneNote Basics

Three notebooks are included when you install OneNote—OneNote 2007 Guide,
Personal Notebook, and Work Notebook. When you click OneNote 2007 Guide,
the first section of OneNote basic information appears. (See Figure 1-6.) On
the right, under New Page, is a list of all pages in this section. To explore this
guide, try clicking each page tab and reading its contents to get an idea of how
OneNote works. Page tabs can be expanded « or collapsed 3 by clicking
the chevrons to the right of New Page. There are also up and down chevrons on
the Notebooks task pane that expands and collapses the view of each notebook.
Be sure to look at Figure 1-7, which provides information about many of the
tools available in OneNote as well as instructions about hyperlinks, audio and
video recordings, tables, and use of OneNote with other applications.

Figure 1-8 shows the Personal Notebook with Personal Information selected.
Sections in this notebook include Shopping, Books, Travel, Recipes, To Do, and
Miscellaneous as noted on the tabs.

) 1 Oneliote basics - Microsaft Office OneNote - 1
: Ele Edit Yiew Inset Format Share Tools Table Window Help _f
@-D-clew- AHED 4 D@ -0 - Wk -YrTag -FC0ip OHL- @ 10% - oiM - |,!_,| I MR

It “ 1) OneNote 20.. | Getting Started with OneNote . Mare Cool Features | Search All Netebooks 2 =
.\ insihole Lo

Work Notebook ¥
E ; AESE L, T S s R S “ | ) New Page

L personai Noteb.. 1. OneNote basics | 1. Onehlote basics |
2. How can OneNote
3. Take notes of man

| = More Cool Features | How are OneNote pages Hlfferent? | pf4: Gather screen clipp

5. How to organize n

Thisisan example of anormal page of notes. You can type anywhere — just clickand type. For e:ampl
6. Search your notes

yourname here. Then try moving it around.

1 7. Work with Outlook |
8. Send notes to other
9. Tag important note
10. Use shared noteb

11. Upgrading from O |

12. More resources

What are all the tabs?

OneNote is a place for gathering, org searching, and sharing L] referenc
materials, and other information. All your notes will be visible here — organized by notebooks, section:
pages. You can create them by dickingFile > New.

| Notebooks: ionsin the current b Pages in the curren
| Start with one or twa. Sections let you organize notes by activities, topics, or | Create as many not

— [ALE.OR D eople inyour life. Start with a few in each notebook, | each section asyou
o’

]
;%Nmmmh B 3

Figure 1-6 OneNote Window: OneNote 2007 Guide Selected
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=] Wark M ook = { =
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| L) personal Noteb.. ¥ | i What else can [ do wit
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. Text recagnition in pi

| 5 Getting Started
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several activities. Click these links to explore. Use the Back arrow button on the toolbar to return to thisp Side Note
@ Multiple computer su

DneNote Mobile

Drag and droj

o Onthe road +
meeh II':gs " Multiple computer support JECH
VE ShOTINg Se5350N OneNote Mobile for mobile devices . - Tables
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Calculator Insert files as printouts
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Drawing teols ¥ Send to Word
Page templates &Q Qﬂ Excel andPawerPaint integraf Calculator
Recordinga meeting Attach files toyournotes Insert files as printout
Audio search Aftach files to your n

fullpeenc Researching a topic ) i i J

=T f Side Note Window Excel and PowerPoint
'

Send Web pages to OneNote OneNote basics on T
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Fullpage view = AT
R 7 assword p on
e i & Using Tablet PC- if you ha G A v
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Dragand drop Drawingtools Audio search
Hyperlinks LassoSelect Full page view
Password protection RIS

I Unfiled Notes

|
|
i minotebooks |||«

Figure 1-7 OneNote Guide: More Cool Features

The third notebook, the Work Notebook, is shown in Figure 1-9 with the Travel
tab selected. It includes sections for Meeting notes, Planning, Research, and Projects.

You will also find it worthwhile to review the online training available from
Microsoft for OneNote. Click Help in the menu bar and choose Microsoft Office
Online to discover the options available.

Using OneNote

When you open OneNote for the first time, you will see a window like that shown
in Figure 1-10—an Unfiled note or page. You can click anywhere inside the page
and write a note, draw something, or paste text or a picture. The note will appear
in a “container” or text box like this:  wemd . The container can be modi-
fied using traditional Microsoft protocols.
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¥

= Person s Financial infarmation
= oo 1 Credit card accounts
= Books, movies, and ...
e Frequent flyer accoun
. Reclpes Examples of what to put in this section T —
| : Lﬁ:m bt + Web site account user names Wedical Informatian
HI 4% E-portfolic-Joos | » Confirmation numbers
.
.

Frequent flier numbers

| ' OneMNote 2007 .. £ Bank accounts and other financial information
s

|| == Getting Started with...
| &= More Cool Features Tips

| + Itis highly recommended that you password protect this section. To password protect a
section, on the File menu, click Password Protect this Section. This prevents other peopl
| from seeing these pages on your sereen and the file will be encrypted.

Important note
You will not be able to retrieve the information in this section if you forget the password.

Use tables to store information. While you are typing, press TAB to create a table and pre|
ENTER to create a new line. For more table options, click the Table menu.

Microsoft Office OneNote 2007 will periodically backup your notes. This occurs while
OneNote is running, To view back-ups, on the File menu, click Open Backup. nes and Bar

Figure 1-8 OneNote: Personal Notebook, Personal Information Selected

NOTE: If you don't see the Untitled Note Page, click the Unfiled Notes button on the
bottom of the Notebooks task pane.

When you put your cursor in a container, it will change to a four-headed arrow
+}-. Click the container, and you can move it anywhere on the page. If the cursor
looks like a two-headed arrow , you can change the width of the container.

To remove what you have typed, select the text and then press Backspace,
Delete; alternatively, you can right-click and choose Delete from the menu that
appears.

To add a new Untitled Note, click the symbol ‘ in the Navigation Pane,
click the New Page command in the Page task pane, or click the New button
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7 About this section - Micrasaft Office OnelNote
i file Edit View Inset Format Share Jools Table Window Help
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=

OneNote 17 .

Blic-|A-%- F

.| sesrch Al Notebooks 2 +|

L """f"“‘ L) Work Noteb.. [ Mesting notes  Project A"\ Project 8" Research | Travel “_ Planni. . Miscell
IiiﬁuﬁNauhoa!!II

\Jpesonstcns. + || Aboutthis section
i B e e

Examples of what to put in this section

Planning a trip? Use Microsoft Office OneNote 2007 to gather all of your travel information in
one place. Store such things as:

» Flightinformation

+ Carrental information

+ Other transportation details

+ Lodging information
.

.

Maps and directions
Itinerary
R 1 sightseei 3

Tips
» Copy information from a Web site into OneNote 2007 as text. If you use Windows

Internet Explarer, look for the OneNote button in the toolbar. Select the information you

want te copy and click this button to send the information to OneNote 2007 in the

Unfiled Notes section.

Capture an article on the Web and insert it into Microsoft Office OneMote 2007asa

searchable image. To do this, on the Insert menu, click Screen Clipping or press

Windows Logo Key = 5.

To save e-mail messages in OneNote 2007, use the Send to OneNote feature in Microsoft

Office Outlook 2007,

To e-mail your travel information from OneNote 2007, go to the page you want to

send, and then, on the File menu, click E-mail.

Need to print everything out? Press the CTRL key and click the page tabs of the pages

I that you want to include. On the File menu, click Print.

S sy

|| 2 Unfiled Notes |

) AllNotebooks  »

I Mew Page
About this section
Tripl
Transportation
Hotel Informatio
Sightseeing

Trip2

i

Figure 1-9 OneNote: Work Notebook, Travel Section Selected

on the toolbar. You will see more untitled note pages appearing in the Page

task pane. )
To see another view of the notebook sections, click the All Notebooks list w

in the Navigation Pane. You will then see a list similar to that shown in Figure 1-11.

Opening a New Notebook, Section, or Page

To open a new notebook, click File and place the cursor over New; a menu will
appear, as shown in Figure 1-12a. If you choose Notebook, the New Notebook
Wizard will appear as shown in Figure 1-12b. From the wizard, it is possible to select
a Research Notebook, a Student Semester Notebook, or several other options. Even
more templates are available online that deal with house hunting, wedding plan-
ning, school, and work, for example. Each notebook can have several sections. New
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.E‘i_u - B AW 2

Toolbar / | search all Notebooks £ + | i

INewPege = » ||
Untitled page

Wednesday, February 11, 2009
537PM

Page tabs
ett Publishe

Untitled Note Page
OR DISTRIB|

nes and Bar
FOR RESAL

.%mones and Barg

| AD NICTDIDIITINARAN 8 Tty AAT FAD DECAL E
Personal information B Getting Started with OneNote

= Shopping & More Cool Features

= Books, movies, and music

S Travel

s Recipes

B Todo

|

Section Symbol

= B TV NkIMkic WV Wi
= Project 8

Figure 1-11 All Notebooks List
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Fi iEdit View Insert Format Share Tools Table Window Help E
New F‘ ] Page Ctrl+N

Open » | Subpage Ctrl+Shift+N
Close this Notebook X' Section

Save As... &= Section Group
Publih as PDF or XPS... il Notebook. |

E-mail... Ctrl+Shift+E Page from Template...
Send To .

@ Explain Choices on this Menu...

Figure 1-12a Opening a New Notebook

MNew Notebook Wizard

Specify the notebook properties

Name:

|

From Template:
) sank

Clients Notebook

Personal Notebaok
Professional Services Notebook

Research Notebook

Shared Notebook - Group Project

Figure 1-12b New Notebook Wizard
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notebooks can be added at any time, just as new

. pages can be added in a section. If you opened
=T PGDN
_J ki ‘[}» ‘ ‘l | the Notebook wizard, click the Close button.

_ 1 NewPage Here is another way to open a notebook

L0 New Subpage page, section, or notebook:

& Blank Template 1. Click New Page jﬁ:w “ above the
" pae . . .

3 More Ternplate Choices and Options... page tabs task pane on the right side. Click

the down arrow. The menu shown in
Figure 1-13a appears.

2. Click the New Page button [JNew ~ in
the toolbar. Or, click the down arrow
beside New on the menu bar, and a menu
appears. See Figure 1-13b.

3.If you choose Explain Choices on this

Figure 1-13a Page Tabs: New Page Option Menu

_] New | ~ Q) Fe L Menu. .., a task pane will appear on the
] Page Ctrl+N right side as shown in Figure 1-14.
) Subpage Ctrl+Shift+ N Here is another way to see the task pane:

1. On the View menu, click Task Pane in the
bottom row to place a check next to the
command.

‘4l Notebook... 2. In the task pane on the right click the down

arrow next to New. Figure 1-15 appears.

You can choose New to see Figure 1-14 or

@ Explain Choices on this Menu... select one of the other alternatives.

Page from Template...

Once a new page is selected, you can alter the
page setup to meet your needs. For example,

Figure 1-13b New Page Button on Toolbar: you can change the font, make a list, use bullets

Menu Options or numbers, and check spelling.

Remember that notes and sections can be

added to a notebook at any time. Unfiled notes

can be moved easily to sections or notebooks. However, it is wise to consider which

kind of tasks you have and which kind of organizational structure will work the best
for you. Remember, too, that notes and notebooks are automatically saved.

Screen Clippings

You can use the OneNote Screen Clipper to copy an image of anything you see on
your computer screen.
To capture a picture, icon, or piece of text on your screen:

1. Press the Windows logo key [#] + S. The screen changes to a filmy white
and the cursor changes to a plus sign.
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| New
new [}

] Mew page
Create a new page at the end

of the current section, based
on the default template,

@ Subpage
Create a new page that
immediately follows the current
page and is grouped with it.

MNew

Research

Document Management
£V Saction Page List
Create a new section in the

current notebook. Tags Summary

Customize My Tags

&= Section Greup
Create a new section group in
the current notebook. Section
Groups are useful for keeping
related sections together,

Page Setup

Templates

Font

i3 Notebook
Create a notebook to contain
all the information related to a
project, class, customer, or
other topic. Pick from
templates for work, school,
and personal use.

List

Bullets
MNumbering
Set Language

Spelling
Templates

Password Protection
New page from template. .,

Start Live Sessi
93 Templates on Office Online Y ot FOF

Jein Live Session

Current Live Session

Figure 1-14 Page Explanations in
Task Pane Figure 1-15 Task Pane
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2. Put the plus sign over a corner of the object/picture you wish to copy; click and
drag until you have selected the image you desire. Release the mouse button.

3. The image will appear on an Unfiled Notes page, along with the date and
time when it was clipped.

Here is another way to prepare to take a screen clipping:

1. Click in the standard toolbar in OneNote; the screen turns white
and you proceed the same way.
2. Another option is to go to the Insert menu and choose Screen Clipping.

If you captured an image off the Internet, as shown in Figure 1-15, the site
address will appear automatically on the page as well.
Copying Text or Images
To copy an image or text from OneNote and insert it into another document:

1. Select the image or text. When you place your mouse arrow over the
image/text, it turns into a four-headed arrow _

2 %

| Screenclipping

p—

Unfiled Notes

More than 150,000 free images and sounds

Images from iStockphoto

Search the iStockphoto collaction of

over 3 milion photographs, ilustrations,

video footage and Flash files.

= Search iStockphoto for higher
resolution images

= Find free iStockphoto images

= Find more fallimages

Downloadfree clip art, photos, animations, and sounds - Microsdft Office Online
http:/foffice microsoft com/en-us/clipart/FX101321031033.2s
Screen clippingtaken: 11/26/2008, 12:14PM

Free clip art

Figure 1-16 Screen Clipping from the Internet
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2. Click the dotted-line box and it looks like this: @----&----0,
3. You have three ways to copy it: Q v Tag ~ ‘?
a. Under Edit on the menu bar, choose Copy, or & ===
b. Click the Copy icon E2 in the toolbar bar, or
C. Press Ctrl+C.
4. Go to the document where you want to place the image:
a. Choose Paste _El] or
b. Press Ctrl+V. paste

Drawing in OneNote

In OneNote, it is very easy to draw images freehand or use buttons on the drawing
toolbar. See Figure 1-17.

If the drawing toolbar does not appear at the bottom of the OneNote window,
click the Drawing Toolbar button . Click the pen, and then try to draw a
figure or flower. You will find that it takes practice! If you have a tablet PC, it will
be kind of fun! Practice with all the shapes and with the many pen styles. After
you have drawn something, select it, and either press the backspace or delete key
or click the Delete button X . Experiment with other tools until you are familiar
with what each one can do. Each image can be resized or moved around the page
in the same way that other containers can.

Side Note

Side Note is a small version of OneNote. It appears in its own small window.
It will stay open on your desktop when you click the Keep Window on Top

Delete
Insertor Remove Duplicate Shapes

l;r

A P | 12 3 5 A

?9‘/- X

~| %7 | Rotate - s

—=

raser Lines, Arrows, & Shapes Line Thickness

Laszo Select Line Color

Type/Selection Mode

Figure 1-17 OneNote Drawing Tools
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Full Page View

Keep Window on Top Tag

ew Page eate Synced Outlook Tazk

Pi'ﬁL\\'léous Page Record Audio Only

Toolbar Optigns

K|

Figure 1-18 Side Note Window

button & asshown in Figure 1-18. You can adjust the size of the window and
pull up other toolbar options at any time.
To open a Side Note window:

1. Press the Windows logo key [ £+ N.

If you opened the Side Note, close it.

Moving Pages, Sections, and Notebooks

Moving large pieces of information is easy in OneNote. Following are some
ways you can do this. Be aware that the target notebook must be open to move

content to it.

To Move This

Do This

A page or subpage within a section

Drag the page tab up or down in the page task pane.

A page to another notebook

Drag the page tab to the desired section tab in the notebook
header or in the Navigation Pane.
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A section within a notebook Drag the section tab left or right in the notebook header; or
Drag the section tab to the desired location in the Navigation
Pane; or
Right-click the section tab, and then click Move. In the Move
Section To dialog box, click the location where you want the
section to go, and then click Move Before or Move After.

A section to another notebook Drag the section tab to a new location in the Navigation Pane; or
Right-click the section tab, and then click Move. In the Move
Section To dialog box, click the notebook where you want to
move the section, and then click Move Into.

A notebook on the Navigation Pane  Drag the notebook title up or down the notebook list.

Other Features

It is easy to send a piece of information, a table, or picture to another Office
Program:

1. Select the pages or section you want to send.
2. Go to File and click Send To. You can choose one of the three options listed
as shown in Figure 1-19.

Notes can also be tagged:

1. Pick a note to tag.
2. Click Tag r1ag ~.
3. A star ¥y will appear in the note’s container.

If you click the down arrow, a menu will appear as shown in Figure 1-20. Many
more choices become available on this menu.
If you are working in Internet Explorer, you can send an image or text to OneNote.

1. Select an image or portion of text or even the whole page.
2. Under Tools & Tools ~ | click the drop-down arrow.
3. Choose Send to OneNote.

Send To Pl Mail Recipient (as Attachment)
Passyord Protect this Section... Microsoft Office Word
Open Backup Blog

Figure 1-19 Sending Pages from OneNote to Another Application
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Drop-Down
Menu for the Tag
Toolbar Button

SAcClp 45| 100% -

8

Show All Tagged Notes
Customize My Tags...

To Do Ctrl+1
Important Cirl+2
Question Ctrl+3
Remember for later  Ctrl+4
Definition Ctrl+5
Highlight Crl+6
Contact Ctri+7
Address Ctrl+8
Phone number Cirl+2
Web site to visit

Idea

Password

Critical

Project A

Project B

Movie to see

Book to read

Music to listen to

LCEHuUE <-BsPFRENZ 295K AN

-

Select More and this menu appears

Remember for blog
Discuss with <Person A
Discuss with <Person B>
Discuss with manager

Send in e-mail

Schedule meeting

Call back

&, Source for article ®/) 7o Do prierity 1
| More... B/ To Do priority 2
%g Remove Tag E Client request
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This section has highlighted just a few of the many things you can do with
OneNote. If you use this program as it is meant to be used, you will end up with
a large collection of information. Even if you use all the tools possible to organize
your information, you may need to search for some information.

1. Go to the Search text box [Search All Notebaoks P ¥ |; click in it.

2. Type the word(s) you are looking for.

3. Click the magnifying glass 0.

4. A list of the matches appears, highlighted in yellow. Click View List, and a

partial description of each match appears on the right side of the window.

Additional Tips

Some additional tips described here will prove helpful as you work through this
book to develop your computer and information literacy.

1. Do not try to complete all of the book exercises at once. Sometimes it is
helpful to come back later, especially when the exercises are not going well
or when fatigue sets in.

2. Pay attention to messages on the screen. They are the computer’s way of
trying to provide help.

3. Use the software sequences found at the end of each lesson on an appli-
cation program to complete the exercises or assignments for that software
program. It is not necessary to memorize the commands, mouse clicks,
or sequences of events. Use the screen clues, prompts, and online help to
guide you through the sequence.

4. Explore additional functions by referring to other reference sources such as
online help, manuals, or reference books. The functions highlighted in this
book were chosen to help you complete the exercises and learn some basics
of how the programs work. Many more functions are available within each
of the software programs presented here.

5. Always back up your files. This point is especially important for the
beginner so that hours of work will not be lost. Open a document and then
save it immediately; don’t wait until you have finished it or finished your
session on the computer.

6. Practice doing assignments from all courses using your computer. It takes
practice to develop computer literacy. The more you use the computer, the
easier and faster tasks will become.

7. Be patient. Learning a new vocabulary and developing new skills take time
and energy.

8. Start collecting information for your e-portfolio using OneNote.
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Summary

This chapter provided an orientation to computer and information literacy. It
described how this book is organized and the conventions used to denote user
actions. Some helpful information about getting started using the school or lab-
oratory facilities was also presented. Instructions related to creating a PDF file
and compressing files were included as well. Also described were the basics of
using OneNote—getting started, opening new notebooks, adding pages or sec-
tions, using the drawing tools, and taking screen clippings. Finally, resources for
learning more about OneNote were described.
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EXERCISE 1 Log In, Download, and Send an Email Attachment

B Objectives
1. Log in to the email program.
2. Download and send an email attachment.

B Activity

1. Log in to the mail program you will be using for this course. You will
receive an email with an attachment from your professor.

2. Open the email and follow the instructions contained in it. It will contain
a compressed file. Download the compressed file using the directions pro-
vided in this chapter. Extract the contents of the file. What was in the com-
pressed file?

3. Send an email to your classmates and professor that contains the following
information:

a. A brief introduction of you, your interests, and so on.
b. A picture of you attached to the email.
4. Read and respond to your classmates’ emails.

EXERCISE 2 Information Literacy Competency Standards for Higher

Education

References 29 .

B Objectives
1. Develop a personal definition of information literacy.

B Activity
1. Go to the Web site of the Association of College and Research Libraries.

a. Type http://www.ala.org/ala/mgrps/divs/acrl/index.cfm

b. Click Standards and Guidelines on the left side of the screen.

c. Move down the list and click Information Literacy Competency Stan-
dards for Higher Education (Jan. 2000).

d. Review the standards by selecting Standards, Performance Indicators,
and Outcomes.
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e. Review the material on information literacy and information technology
at this site.
2. From this material, develop your own definition of information literacy.
3. Place this definition in OneNote for later addition to your e-portfolio. Keep
a weekly journal of the skills you are developing in this course.

EXERCISE 3 Electronic Reference Formats

B Objectives
1. Find sources for styling electronic references.
2. Recognize the appropriate format for electronic references used by the
American Psychological Association (APA).

B Activity
Use OneNote to keep a notebook of your findings regarding how to format
electronic references. If necessary, review the processes described earlier in this
chapter. In the Word chapter, you will learn how to use templates and the Ref-
erences tab to automatically format your papers and references in the correct
style.
1. Go to the Dartmouth Institute for Writing and Rhetoric.
a. Type http://www.dartmouth.edu/~writing/.
b. Click Sources & Citation at Dartmouth.
c. Download a copy and review it. (Note: You will need the PDF add-in
utility on your computer. If necessary, review the process for adding the
PDF utility that was described earlier in this chapter.)
2. Go to APA Style.Org.
a. Type http://www.apastyle.org/elecref.html.
b. Click Electronic media and URLs.
c. Review the article.
3. Review the following sources:
a. Type http://www.dianahacker.com/resdoc/.
i. Hold the mouse pointer over Sciences Section and click Nursing and
health sciences.
ii. Review the sections on databases and indexes, Web resources, and
reference books.
b. Go to “The Owl at Purdue” and review its APA Formatting and Style
Guide.
i. Type http://owl.english.purdue.edu/owl/resource/560/01/.
ii. Scroll down and choose No. 10: Reference List: Electronic Sources.
iii. Review the materials.
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EXERCISE 4 Compare Four Information Literacy Tutorials

B Objectives
1. Review three different information literacy tutorials.
2. Compare and evaluate them.

B Activity
1. Compare the following four information literacy tutorials in terms of their
ease of use, ease of navigation (i.e., ability to move around them), content,
and value to you.
a. Information Literacy Tutorial: University of Wisconsin-Parkside Library
Type http://www.uwp.edu/
Under Quick Links, click Library
Click the Information Literacy Tutorial under Guides and Tutorials
Click Start the Tutorial button
b. Information Literacy Tutorial: Five Colleges of Ohio
Type http://www.ohio5.org/
Click Library Resources and Initiatives
Click Information Literacy Projects
Click Information Literacy Tutorial
c. Information Literacy Tutorial: Penn State University Libraries
Type http://www.libraries.psu.edu/psul.html
Under Get Help on the right side of the screen, click Tutorials
Click Information Literacy & You
Click Searching Online Databases
Now, click Using Web Resources on the left side of the screen
Review other sections as desired.

EXERCISE 5 Explore the Uses of e-Portfolios

B Objectives
1. Describe the essentials of an e-portfolio.
2. Describe the relationship between information literacy and e-portfolios.

B Activity
1. Go to the e-portfolio site at Penn State:
a. Type http://portfolio.psu.edu/.
b. Click the About link.
c. View some of the other links such as Collect, Select, and Reflect.
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2. What is an e-portfolio?

3. How does it relate to information literacy?

4. If you are interested in learning more about e-Portfolios, check out this
site: http://www.elearnspace.org/Articles/eportfolios.htm.

ASSIGNMENT 1 Learning About Your School's Computer Policies

B Directions
Use your school’s intranet site to find the answers to the following questions:

. Find your school’s Web site. What is its Uniform Resource Locator (URL)?
. Is there a technical support center? Is it known by another name?

. What are the policies and procedures of the academic computing center?
. Can you download these policies?

How does a student set up network and email accounts?

Which operating systems and software does the center support?

Is there a laptop lease/buy program at your school?

Does your school have an e-Portfolio system for students?

Is there an e-learning center? If so, which classes are available?

What are the hours for technical support?

What was the most valuable thing you learned from this assignment?

—ocLENOO A WN

-_

Turn in a summary of what you learned answering these questions.
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